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1 OpendTect Pro

OpendTect PO

OpendTect Pro is an extended version of OpendTect for professional users.

OpendTect Pro users benefit from the following extra functionality: a direct link to
Petrel*; a basemap utility; a PDF3D tool to capture 3D images in pdf format; a Thalweg
tracker for auto-tracking seismic facies; and an accurate ray-tracer for computing angle
stacks and AVA attributes.

OpendTect Pro can be extended further with commercial plugins developed by
dGB and its partners. This document describes the functionality in the Pro layer (that is
available to all commercial users) as well as the plugins developed by dGB Earth
Sciences. The user documentation of plugins developed by other vendors is given in

separate documents.

*is a mark of Schlumberger.
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1.1 PetrelDirect

PetrelDirect is an OpendTect Pro feature for direct data transfer between OpendTect

and Petrel* projects. Reading data from a Petrel* project is available in various

OpendTect workflows via insert icon % , Which allows to either access data directly

from a Petrel* data store via links or physically copy data to an OpendTect project.
Either method gives full potential for manipulation, interpretation and processing. Writ-

ing data to a Petrel* project is also available in various OpendTect workflows by choos-

ing EPetrelDirect output format.

Survey > Import and Survey > Export menus have PetrelDirect option for

supported objects.

Full two-way access (Petrel* <> OpendTect):

Faults (since 6.0.4 release) and FaultStickSets

3D horizons

2D and 3D seismic

Wavelets

Wells (tracks, time-depth models and logs)
One way access (Petrel* > OpendTect):

* 2D horizons
* 3D prestack seismic

* Wells (markers)

The images below show an example of an OpendTect project with key data being read

directly from the Petrel* data store.
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OpendTect () and Petrel* (r) showing a linked demo project

PetrelDirect status button E (in the lower right corner of the main OpendTect

window) helps to monitor the status of the connection to Petrel*. Pushing the button will

lead to the Settings Window. The drop-down menu next to it allows to directly control

the status of the connection:

° E - disabled (drop-down menu next to it allows to Enable connection)

° - uninitialized (connection is enabled, i.e. will be activated once PetrelDirect

is used; drop-down menu next to it allows to either Disable connection or Initialize

now)

° ﬁ - active (drop-down menu next to it allows to Disable connection)

*is a mark of Schlumberger.
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1.1.1 Survey Setup From Petrel*

An OpendTect survey can be quickly set up from an existing Petrel* project. Go to Sur-

vey > Select/Setup or click on {? icon in the main OpendTect window and then click

on | €3 icon to Create New Survey.

b Create New Survey = B

Specify new survey parameters

survey name NewSurvey from Petrel

Available data ¥ 3D 2D

Initial setup |2 Use PetrelDirect

ser Scan SEG-Y file(s)

p4 Set for 2D only

% Copy from other survey
i Enter by hand

Z Domain ® Time ) Depth

O Next | @ Cancel
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Use PetrelDirect option of Initial setup forwards to Get survey setup from Petrel* win-

dow which looks different depending on the availability of 2D and 3D seismic survey

folders in Petrel* project.

3D: choose one of the 3D seismic folders either in the tree view or using drop-down

menus.

i Get survey setup from Petrel - E

Base the OpendTect survey on

4 4 Seismic
o s By All 3D seismic folder
LpIEEETBIR 2 B 3D Seismic Data survey

Velocity Cubes

|3D Seismic Data survey v| in |AII 3D seismic folder v|

QoK | @ cancel @ Help

2D: choose one or more 2D seismic surveys which will be used to generate a sug-

gested survey setup and set the percentage of data to be left outside the survey box.
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fe Get survey setup from Petrel - [

Mote: Only 2D data available.
Generated setup will be no more than a suggestion.

Base the OpendTect survey on

2 (9 Seismic

& Survey 1
Survey 2
B Survey 3
B Survey 4

Leave 5 % of the data outside the survey box

() OK | © Cancel @ Help

The Edit Survey Parameters windows opens with all survey with pre-filled parameters

from the selected Petrel* project set-up.
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f—':! Edit Survey Parameters

Survey name |New8unmy_from_Pelrel |

Location on disk |C:\Surveys
Survey type Both 2D and 3D ~ %

Ranges/coordinate settings | Enter below e

-:- Survey ranges @ Coordinate settings 2 1/C to X/Y transformation <& Coordinate System

In-ine range (100 [3][750 3|Step [1 2] Nr. In-lines: 651

Y
-

Cross-line range |300

11250 %] Step |1 4| Nr. Cross-lines: 951

Z range [0 |[1848 | Step [4 | milisecond v

Display depths in @ Meter () Feet

Seismic Reference Datum (m) |0 |

= Apply

QCancel 0

Free space on disk: 25.40 GB

The survey parameters need to be checked, and edited if required.

*is a mark of Schlumberger.
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1.1.2 Import From Petrel*

Reading data from a Petrel* project is available in various OpendTect workflows via

=
insert icon "= , which allows to either access data directly from a Petrel* data store via

links or physically copy data to an OpendTect project. Either method gives full potential

for manipulation, interpretation and processing.

Survey > Import menus have PetrelDirect option for supported objects.

L

There are two ways to use data from a Petrel* project in OpendTect:

* Link to Petrel™:
° no data duplication;
° data is available only when the Petrel* project is running and PetrelDirect

connection is active (i.e. Petrel* license is tied).

* OpendTect copy:.
° physical copy in OpendTect format;
° no restrictions on data access (i.e. Petrel* license is not tied and data is

accessible to all users).
The following data can be read from Petrel* to OpendTect:

* Faults (since 6.0.4) and FaultStickSets

* 2D and 3D horizons

* 2D and 3D seismic

* 3D prestack seismic

* Wavelets

* Wells (tracks, time-depth models, logs and markers)
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Use Ctrl+A and Ctrl+Shift+A shortkeys to select/de-select all items in the

list.
It is now possible to import/export multiple objects.

Batch processing for importing objects is now available for Faults, FaultSticks, Hori-
zons and Seismic Cubes. A check box to use the original name is provided which
should be checked in case the same needs to remain identical to the object in the
Petrel project. Any name entered into the field adjacent to this will be used as the 'base

name' for the objects.

*is a mark of Schlumberger.
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1.1.2.1 Import Fault From Petrel*

Petrel* fault interpretation can be accessed in OpendTect as Faults by clicking on

PetrelDirect insert icon rg,. in the following places:
B
* Manage Fault window (Survey > Manage > Faults... or click on =& icon in the

Manage Data toolbar)
» Select Input Fault(s) window when adding Fault(s) to the 3D scene, 2D viewer or

Basemap by right click on Faultin the tree > Add)

Select Fault Interpretation(s) window allows to select faults from Petrel* project and cre-

ate either Link to Petrel* or OpendTect Copy.

& Import FaultStickSet — O X

O - Filter 'S

~ [ Seismic A
~ [T Interpretation folder 1

v 07 FaultSet_1684
[] X FaultSet_16840
[] &% FaultSet 16841
[] &% FaultSet 16842
[] &% FaultSet 16843
[] &% FaultSet 16844
[] &% FaultSet 16845
[] &% FaultSet 16846
[ & FaultSet 16847 bt

Create O Link to Petrel ® OpendTect Copy

[ Use Original Name FaultStickSet | ~| | © Select ... | | ¥ dGB v

[ Execute in Batch Options ...

o | @

Fault Import User Interface
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OpendTect does not support crossing fault sticks (a fault plane cannot
cross itself). If faults were picked on inlines, crosslines and horizontal slices,
only the largest subset of the three will be used to import the faults. Manual
editing (removing unwanted sticks) is possible after import and might be

required in some cases.

*is a mark of Schlumberger.
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1.1.2.2 Import FaultStickSet From Petrel*

Petrel* fault interpretation can be accessed in OpendTect as FaultStickSets by clicking

2
on PetrelDirect insert icon "= in the following places:

* Manage FaultStickSet window (Survey > Manage > FaultStickSets... or click on
il

“~ kicon in the Manage Data toolbar)

» Select Input FaultStickSet(s) window when adding FaultStickSet(s) to the 3D

scene, 2D viewer or Basemap by right click on FaultStickSetin the tree > Add)

Select Fault Interpretation(s) window allows to select faults from Petrel* project and cre-

ate either Link to Petrel* or OpendTect Copy.

) Import FaultStickSet - ] X
O - e ] &
v E seismic A

~ [ Interpretation folder 1
v~ [ FaultSet_1684
[] X& FaultSet_16840
[] & FaultSet_16841
[] & FaultSet 16842
[] K& FaultSet_16843
[] A% FaultSet_16844
[ &% FaultSet_16845
[ & FaultSet_16846
[[1 4% FaultSet 16847 ~

Create O Link to Petrel @ OpendTect Copy

[J Use Original Name FaultStickSet | V| 6 Select ... i dGB ~

[ Execute in Batch Options ...

Qoo | @

FaultStickSet Import User Interface

FaultStickSet in OpendTect is a set of fault sticks which can be grouped into

faults.

*is a mark of Schlumberger.
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1.1.2.3 Import Horizon From Petrel*

Petrel 2D and 3D horizons along with horizon attributes can be accessed in OpendTect

2
by clicking on PetrelDirect insert icon = in various workflows.

*is a mark of Schlumberger.
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1.1.2.3.1 Import 2D Horizon From Petrel*

Petrel* 2D horizons can be accessed in OpendTect by clicking on PetrelDirect insert

icon % in the following places:

* Manage 2D Horizons window (Survey > Manage > Horizons > 2D... or click on
I icon in the Manage Data toolbar)

» Select Input 2D Horizon(s) window when adding 2D Horizon(s) to the 3D scene,
2D viewer or Basemap by right click on 2D Horizonin the tree > Add)
» other workflows, including creating flattened scene, etc.

Select Horizon Interpretation(s) window allows to select 2D horizons from Petrel* pro-
ject and create either Link to Petrel* or OpendTect Copy.
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_oEN

Select Horizon Interpretation(s)

4 5 Seismic
4 IF |nput To Structural model
4« TF Hoarizons
4 [ Time and Depth Honzons 2D and 3D

s BCU

B T Tarbert

B T Ness

e T Etive

[+l Link to Petrel

Create
[1# OpendTect Copy

€9 OK | @ Cancel @ Help

In order to ensure smooth import of a 2D horizon, OpendTect project must

contain 2D line geometries with names matching the Petrel* 2D seismic sur-

L

vey associated with that 2D horizon.

*is a mark of Schlumberger.

-36 -



1.1.2.3.2 Import 3D Horizon From Petrel*

Petrel 3D horizons and surfaces can be accessed in OpendTect as 3D Horizons by

2
clicking on PetrelDirect insert icon = in the following places:

* Manage 3D Horizons window (Survey > Manage > Horizons > 3D... or click on

I icon in the Manage Data toolbar)

» Select Input Horizon(s) window when adding 3D Horizon(s) to the 3D scene, 2D
viewer or Basemap by right click on 3D Horizonin the tree > Add)
» other workflows, including 3D Horizon gridding and filtering, creating flattened

scene, etc.

Select Horizon Interpretation(s) window allows to select 3D horizons and surfaces from

Petrel* project and create either Link to Petrel* or OpendTect Copy.
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#  Select Horizon Interpretation(s) = =

1 & T_Etive A
(] & -2300
« 0 Gulfaks Input
2 [ Surfaces (Time)
& Seabed
& Base Cretaceous
& Top Tarbert
& Top Ness
& Top Etive
2 [ Faults (Time)
4 [ Fault Surfaces

] & Boundary Fault
— & O | - n W

L4 Link to Petrel

Create
[ 1% OpendTect Copy

O oK | © Cancel @ Help

OpendTect project is based on a particular 3D survey set up. Petrel* 3D
horizons associated with 3D seismic surveys which geometries are different
and Petrel* surfaces based on grids which are different are snapped to an

OpendTect grid during import.

*is a mark of Schlumberger.
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1.1.2.4 Import Seismic From Petrel*

Seismic data from Petrel* project (2D poststack; 3D post- and prestack) can be

=
accessed in OpendTect by clicking on PetrelDirect insert icon = in various workflows.

*is a mark of Schlumberger.
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1.1.2.4.1 Import 2D Seismic From Petrel*

Petrel* 2D seismic can be accessed in OpendTect by clicking on PetrelDirect insert

icon % in the following places:

* Manage 2D Seismics window (Survey > Manage > Seismics > 2D... or click on
i
-ﬁﬁ icon in the Manage Data toolbar)

» Select 2D Line(s) window when adding 2D Line(s) to the 3D scene by right click
on 2D Linein the tree > Add)

» other workflows, including attribute definition and processing, etc.

Select 2D Line Collection(s) window allows to select 2D seismic data from Petrel* pro-

ject, provide a dataset name in the Aftribute field and create either Link to Petrel* or

OpendTect Copy.
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Select 2D Line Collection(s)

o

4 [ survey sub folder n11-20
4 n11 [Realized] 1
4 n12 [Realized] 1
P4 n13 [Realized] 1
4 n14 [Realized] 1
4 n15 [Realized] 1
P4 n16 [Realized] 1
4 n17 [Realized] 1
4 n18 [Realized] 1
P4 n19 [Realized] 1

4 n20 [Realized] 1

4 [[@ 2D Seismic - seismic survey

1 4 2DInline 152 Time

L]

Attribute ' Seismid v| © Select ...
L4 Link to Petrel
Create
[ 1 OpendTect Copy
O oK | @ Cancel @ Help

2D seismic data in OpendTect is organized in datasets and 2D line geo-

L

metries. A dataset contains unique data for each 2D line, i.e. seismic data

characterized by common processing history or a specific seismic attribute.

*is a mark of Schlumberger.
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1.1.2.4.2 Import 3D Seismic From Petrel*

Petrel* 3D seismic cube can be accessed in OpendTect by clicking on PetrelDirect

2
inserticon "= in the following places:

* Manage 3D Seismics window (Survey > Manage > Seismics > 3D... or click on

i
-ﬁﬁ icon in the Manage Data toolbar)

* Select window when adding a seismic attribute display at In-line/Cross-line/Z-
slice/3D Horizon in the 3D scene
» other workflows, including attribute definition and processing, etc.

Select Seismic Cube window allows to select 3D seismic data from Petrel* project and
create either Link to Petrel* or OpendTect Copy. The tree view and the drop-down

menus offer alternative ways to select data from a Petrel* project.

& Import Petrel Seismic Cube - O X
0 - e[ ] s
v Seismic ol

~ [ F3Demo

O 4 Dip steered median filter

[ & 9-3 Fault enhancement filter

O Fault_Likelihood_Thinned_from_DSMF_seis

] & Min Similarity on FEF seismic

[ (& Smoothed_Seismic

] (3 Spec Decomp FFT 24Hz

Oa Spec Decomp FFT 44Hz

[ & Spec Decomp FFT 64Hz

163 1 Orininal hd

Wolume subselection |1UUISUU—?5[}IHZSU (463 samples) | e Select ...

MNull traces @ Discard O Pass
[ Scale values:  Shift/Factor

Create O Link to Petrel ® OpendTect Copy

[ Use Original Name Output Cube ‘ v‘ © Select .| | #CBVS ~

[] Execute in Batch Options ..

Qo @

Added by dGB's Petrel/OpendTect connection

Seismic Cube Import User Interface
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Petrel* 3D seismic cube must have the same geometry as OpendTect sur-

vey set up. The easiest way to achieve this is to Get survey set up from

L

Petrel* when setting up a survey and choose an appropriate Petrel* seismic

survey folder as the geometry source.

*is a mark of Schlumberger.
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1.1.2.4.3 Import 3D prestack Seismic From Petrel*

Petrel 3D Prestack seismic dataset can be accessed in OpendTect by clicking on

PetrelDirect insert icon % in the following places:

* Manage Prestack Data window (Survey > Manage > Seismics Prestack > 3D... or

click on -ﬁ?l icon in the Manage Data toolbar)

» other workflows, including Prestack attribute definition and processing, etc.

Select Prestack Seismics window allows to select 3D prestack seismic data from
Petrel* project and create either Link to Petrel* or OpendTect Copy. The tree view and

the drop-down menus offer alternative ways to select data from a Petrel* project.

i Select Pre-Stack Seismics - 0

4 m Pefrel2014 1 demo project pet
Input Pre-Stack Seismics |22 PrestackDataSef{SEGY - StacksT ...

PrestackDataSet] = in Petrel2014_1 der -

L+ Link to Petrel

Create
[ 1% OpendTect Copy

O OK | @ Cancel @ Help

Petrel* 3D prestack data must have compatible geometry with OpendTect

survey set up. The easiest way to achieve this is to Get survey set up from
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Petrel* when setting up a survey and choose an appropriate Petrel* seismic

survey folder as the geometry source.

*is a mark of Schlumberger.
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1.1.2.5 Import Wavelet From Petrel*

Petrel* wavelets can be accessed in OpendTect by clicking on PetrelDirect insert icon

% in the following places:

* Manage Wavelets window (Survey > Manage > Wavelets or click on “'.'l icon in

the Manage Data toolbar)

Select Wavelet(s) window allows to select wavelets from Petrel* project and create
either Link to Petrel* or OpendTect Copy.

) Import Petrel Wavelet

- | .
- Filter ‘J
v [ Seismic
] o stat 120
(] =i tmp_bp
Scale factor |1 |
Create O Link to Petrel ® OpendTect Copy
[] Use Original Name | V| € Select .

Run o Close 0

Added by dGB's Petrel/OpendTect connection

Import Wavelet User Interface

*is a mark of Schlumberger.
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1.1.2.6 Import Well From Petrel*

Petrel well data (deviation survey, time-depth model, logs and well tops) can be

2
accessed in OpendTect by clicking on PetrelDirect insert icon = in the following

places:

* Manage Well window (Survey > Manage > Wells... or click on sl icon in the Man-
age Data toolbar)
* Load Well(s) window when adding well(s) to the 3D scene or Basemap by right

click on Wellin the tree > Add)
» other workflows, including well-to-seismic tie, Log attribute definition and pro-

cessing, etc.

Select Well(s) window allows to select wells from Petrel* project and create either Link
to Petrel* or OpendTect Copy. Active time-depth model in a Petrel* project is always

used.
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™ Select Well

e

Filter

v Ul F2 Block

] A Fo21

v B F3 Block

] A FO3-2
[] A FO34

v Ul F6 Block

[] A FO&-1

WellLogs
Markers

<All>

' © Select

<All>

O Select __

Create () Link to Patrel ® OpendTect Copy

& oK

Import Well User Interface

Selection of well logs and markers.

* By default all well logs and markers are selected.

Qcancel @

* To change the default within the current import session: highlight one well in the

tree and click Select buttons to make a selection of well logs and markers which is
automatically applied to all the wells.

Use Ctrl+A and Ctrl+Shift+A shortkeys to select/de-select all items in the list.
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*is a mark of Schlumberger.
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1.1.2.7 Import Pointsets and Polygons From Petrel*

Petrel pointsets and polygons can be accessed in OpendTect by clicking on PetrelDir-

2
ectinserticon "=® in the following places:

* Manage Pointset/Polygons Windows (Survey > Manage > Pointsets/Polygons...

or click on the “*' icon in the Manage Data toolbar). When adding from

PointSet/Polygon manager, user will have a selection box to choose which kind of

object they want to import from Petrel*

* Load Pointsets (Polygons) window when adding pointsets (polygons) to the 3D
scene or Basemap by right clicking on Pointsets (Polygons) in the tree > Add).

The relevant dialog box pops up.

Import Pointsets (Polygons) window allows to select Pointsets (Polygons) from Petrel*

project and create either Link to Petrel* or OpendTect Copy.

# Import Petrel PointSet - ]} X

0 - Filter r

Create O Link to Petrel ® OpendTect Copy
[ use Original Name PickSet Group | O Select ... ¥ dGB ~

N Do | @

Selection of well pointsets (polygons)

By default all pointsets (polygons) are selected.
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To change the default within the current import session: highlight one polygon (point-

set) in the tree and click Select buttons.

Use Ctrl+A and Ctrl+Shift+A shortkeys to select/de-select all items in the list.

*is a mark of Schlumberger.
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1.1.2.8 Import All Data From Petrel* at Survey

Creation

This OpendTect Pro feature facilitates the import of an entire project from Petrel* to

OpendTect during the survey creation phase.

All data objects are supported (including but not limited to: survey parameters, seismic

2D/3D, pre-stack seismic, horizon 2D/3D, fault, pointset, polygon, wavelet and wells)

and can be copied in a single click of a button.

This enables the user to do his or her seismic interpretation work in OpendTect Pro and

push these interpretations back into Petrel* for subsequent modeling work.

The initial steps in this workflow are similar to the workflow described in section 1.1.1

Survey Setup From Petrel*.

Firstly, specify the creation of a new survey using the PetrelDirect option in the initial

setup:
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@ Survey Setup and Selection - O X

ﬂSun.fey Data Root ... |C:\Surveys | o @
F3_Demo_2020 &

N = Lol =z
F3_Demo_2020_20i F3 Demo 2020

(4

My_New_Survey & Create New Survey

Specify new survey parameters

Survey name |SurveyFromPetreI|

Available data [+ 3D 2D

Initial setup | Use PetrelDirect ~ | Boortzso
< Scan SEG-Y file(s)

74 Set for 2D only

¢! Scan Navigation Data

@ Information & Copy from other survey

T Read from Survey Setup file v

In-ling
Cross—-1ling
Z rang Z Domain @ Time O Depth
Inl/Crl bj

s
In-line ozigj QCanceI 0

Lococromr o WourveyS o Domo_EUsnw

e 31N

Qcancel @

Then select the Petrel* seismic survey to be used for creating the new OpendTect pro-

ject:
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@& Edit Survey Parameters - O *

Survey name ‘SurveyFromPetrel

Location on disk C:\Surveys
Survey type Both 2D and 3D v

Ranges/coordinate settings Enter below ~

1 Survey ranges @ Coordinate settings B I/C to X/Y transformation < Coordinate System

In-ling — ] (o [~ ] — [a]
& Get survey setup from Petrel
Cross-lin
Base the OpendTect survey on
4 v E Seismic
Display de Input Seismic Survey [E F3 Demo
Seismic Reference Daty F3 Demo ~ | In Seismic “
Qcancel @
= Apply

QOK €3 cancel 9

Free space on disk: 49.17 GB

Upon clicking OK in the Edit Survey Parameters dialog box, a message asks if we

would like to import data or not:

| ‘& Specify X

‘ o Proceed to import data?

o

If the user wants to proceed with importing data at this time (pressing Yes), then the

Object Selection dialog box is shown.

The dialog box depicts the tree as seen on Petrel* side with identical icons.
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The tree can be filtered in two ways, either on the basis of name of the object or on the

basis of object type, or in combination:

rvey Object Selection

Select Datatypes |All Objects ii

well | =] &2

Wavelet

Harizon Grid

Fault Interpretation
3D Horizon

Seismic Cube

A F03-2
A F03-4
v (@ F6 Block
A F06-1
v E Seismic
v [E F3 Demo
4 Dip steered median filter Petrel
Smoothed_Seismic Petrel
1 Original Seismics Petral
1 Original Seismics Petrel [Realized] 2
Interpretation folder 1
8 Demo 0 —> FS4 Petrel
8 Demo 1 —> MFS4 Petrel
8 Demo 2 > FS6 Pelrel
& Demo 3 --> Top Foresets Petrel
# Demo 4 —> Truncation Petrel
84 Demo 5 —= FS7 Petrel
& Demo 6 > FS8 Petrel
# Demo 7 --> shallow Petrel
# Demo a > Base Tertiary Petrel
# tst2del_Inter Demo 0 —> FS4
& tst2del_Surface_Demo 0 > FS4
KE® fitA_AL_2del

] Execute in Batch Options ...

€3 cancel 9

The Datatypes list is populated with the data types available in the selected Petrel* pro-

ject that are supported by OpendTect.
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Note: All OpendTect data types are now supported - Seismic 2D/3D, Pre-stack Seis-
mic, Horizon 2D/3D, Faults, FaultStickSets, PointSets, Polygons, Wavelets and Wells

Upon selecting the required objects, they will be imported and saved in the newly-cre-

ated OpendTect project.

If a large amount of data needs to be transferred to OpendTect, it is recommended to

use the Batch option to speed up the processing.

*is a mark of Schlumberger.
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1.1.3 Export To Petrel*

Writing directly to Petrel* data store is available in various OpendTect workflows by

%
choosing s PetrelDirect output format.

The following data can be written directly to Petrel* data store:

* FaultStickSets

* 3D horizons and horizon attributes
* 2D and 3D seismic data

* Wavelets

The example below shows processing the dip-steered similarity attribute to be output

directly to Petrel* project.

Quantity to output | Dip-Steered Similarity > | © select..

Volume subselection |1UD!300—T50!‘1250 (463 samples) | e Select ..

Mull traces (@ Discard () Pass

[] Scale values: ShiftFactor

Output Cube | Dip-Steered Similarity from OpendTect v || € Select .| |[5]PetrelDirect

Batch execution |Single Process hd | {:} Options ..
I_@DK | ‘ gCancelH eHeIp |

Click on Select button to choose an output Petrel* folder, otherwise the data

is written to the first appropriate folder.

*is a mark of Schlumberger.
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1.1.3.1 Export Fault To Petrel*

Currently only FaultStickSets can be written to Petrel* data store as Fault Interpretation

object.

*is a mark of Schlumberger.
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1.1.3.2 Export FaultStickSet To Petrel*

OpendTect FaultStickSets can be written directly to Petrel* data store as Fault Inter-

pretation object by choosing EPetrelDirect output format in the following places:

* Right-click on a fault stick set in the Tree of 3D scene or 2D viewer and choose

Save as:

e Output selection

EY <

Cutput FaultStickSet | Fault_01] W

© select ...

[M] PetreiDirect ~ |

Replace in tree

O ok

Q Cancel

@ Help

Click on Select button to choose an output Petrel* folder, otherwise the data

is written to the first appropriate folder.

e Save FaultStickSet as window:
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Pl
|

Save FaultStickSet as

o

Cutput FaultStickSet

Filter |*

FSS_01
FSS_02

= 53815-Grid-Faultsticks =

3% X B [

Write to

L] PetrelDirect -

Putin

-

Mame

() cancel

*is a mark of Schlumberger.
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1.1.3.3 Export Horizon To Petrel*

Writing seismic horizons directly to Petrel* data store is available in various OpendTect

windows by choosing EPetre/Direct output format. Currently only 3D horizons are

supported.

*is a mark of Schlumberger.
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1.1.3.3.1 Export 3D Horizon To Petrel*

Writing 3D horizons directly to Petrel* data store is available in various OpendTect win-

.
dows by choosing PetrelDirect output format:

* Right-click on a 3D horizon in the Tree of 3D scene or 2D viewer and choose

Save as:

e

QOutput selection

Area subselection |1UD!30D-?50!125D (463 samples)

O Select..

S oEN

Qutput 3D Horizon | FS4_harizon|

<

© Select ..

Replace in tree

[+] PetrelDirect -

9 oK ) Cancel @ Help

* In various workflows, such as gridding, filtering, etc.:
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e Haorizon Gridding = b

Scope |Convex Rl v|

Inl/Cri Step |1 IE |

[] Keep holes larger than (m)

Algarithm |Continuous curvature - |

Tension |U.25 |

Search radius (m) | ] |

Save Horizon (@ As new () Overwrite

Output Horizon | FS4_gridded v| © select... |[}]PetreiDirect v

[ ] Display after create

\_IODK ||QCancel|| eHelp |

Click on Select button to choose an output Petrel* folder, otherwise the data

is written to the first appropriate folder.

e Save 3D horizon as window:
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=

Save F54 horizon as

Cutput 3D Haorizon

Write to

Seismic Folder

Putin

Mame

Filter *

constl

=Demo0—=F34 =
Demo 1 —-= MFS4

Demo 2 —=F56

Demo 3 —= Top Foresets
Demo 4 —= Truncation
Demo 5—=F37

Demo 6 —=F358

[ ] PetreiDirect ~

*  in - |E Select ..

F34 horizon

a oK ) cancel

* Under Survey, Export Horizons with PetrelDirect:
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& Export 3D Horizon to Petrel

- Filter |*

Input 3D Horizon |l Demo 0 —> FS4 A
[]Demo 1 —-> MFS4

[l Demo 2 —> FS6

a []1Demo 3 —> Top Foresets

[] Demo 4 --> Truncation

[ ] Demo 5 --= F57

[ ] Demo 6 —> FS8

[] Demao 7 —=> shallow v

[~

=@ 0

Horizon properties/attributes

Subselection Type @ Use complete Area (O Truncate Area

Area subselection |1[}[}f300-?50f1250 (463 samples) | € Select .

Seismic Folder |F3 Demo v | In | Seismic v ] select

Save as @ Horizon Interpretation ) Surface

Base Name | ~ | Put in | Interpretation fol - E Select ...

N O cose

On the Petrel side, multiple seismic surveys are supported.

Save as Horizon Interpretation or Surface: It is a new option in Version 6.6.0 that
allows to export a surface as Horizon Interpretation or as Surface. A Surface is not
bounded by seismic survey dimensions, it can exist across multiple seismic surveys.

Whereas, Horizon Interpretation can only exist within a seismic survey.
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OpendTect is created on the basis of single survey dimensions, hence no distinction
between Surface and Horizon Interpretation. When a horizon is imported to
OpendTect, it is imported as surface (i.e. even if data is outside survey ranges it will be
displayed). But when exporting to Petrel, the user needs to make a clear distinction

between Surface and Horizon Interpretation.

Use Complete Area: This option as per its name does not truncate the area. In case
the surface is greater than the seismic cube, a warning message will pop up stating
these facts. If a user still wants to transfer such surfaces as Horizon Interpretation, it will

be truncated according to survey dimension.

Truncate Area: This allows subselection of area.

Base Name: This allows a common string to be added before the name of the object
being exported. If kept blank original name of object will be used to create an object on

Petrel* side. This option is available in all export Petrel* dialog boxes.

*is a mark of Schlumberger.
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1.1.3.4 Export Seismic* To Petrel

Writing 2D and 3D seismic data directly to Petrel* data store is available in various

OpendTect windows by choosing EPetrelDirect output format.

*is a mark of Schlumberger.
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1.1.3.4.1 Export 2D Seismic To Petrel*

Writing 2D seismic data directly to Petrel* data store is available in various OpendTect

workflows by choosing EPetrelDirect output format:

processing 2D seismic attributes;

copying 2D seismic data;

creating 2D grid and extracting 2D data from 3D seismic

Click on Select button to choose an output Petrel* folder, otherwise the data

is written to the first appropriate folder.

*is a mark of Schlumberger.
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https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#processing/create_seismic_output/attributes/create_2d_output.htm%3FTocPath%3D6%2520Processing|6.1%2520Create%2520Seismic%2520Output|6.1.1%2520Attributes|_____1
https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#survey/manage/manage_seismics/manage_2d_seismics/copy_data_set.htm%3FTocPath%3D4%2520Survey|4.5%2520Manage|4.5.12%2520Manage%2520Seismics|4.5.12.2%2520Manage%25202D%25C2%25A0Seismics|_____2
https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#processing/create_seismic_output/conversions_2d_to_3d/create_2d_grid.htm
https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#processing/create_seismic_output/conversions_2d_to_3d/create_2d_grid.htm

1.1.3.4.2 Export 3D Seismic To Petrel*

Writing 3D seismic data directly to Petrel* data store is available in various OpendTect

windows by choosing EPetre/Direct output format:

» processing 3D seismic attributes, Volume builder output, Bayesian Classification,

etc.;

* operations on 3D seismic volumes such as copying and merging.

Click on Select button to choose an output Petrel* folder, otherwise the data

is written to the first appropriate folder.

*is a mark of Schlumberger.
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https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#processing/create_seismic_output/attributes/create_3d_output.htm%3FTocPath%3D6%2520Processing|6.1%2520Create%2520Seismic%2520Output|6.1.1%2520Attributes|_____2
https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#processing/create_seismic_output/volume_builder_output.htm%3FTocPath%3D6%2520Processing|6.1%2520Create%2520Seismic%2520Output|_____9
https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#processing/create_seismic_output/bayesian_classification.htm%3FTocPath%3D6%2520Processing|6.1%2520Create%2520Seismic%2520Output|_____4
https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#survey/manage/manage_seismics/manage_3d_seismics/copy_cube.htm%3FTocPath%3D4%2520Survey|4.5%2520Manage|4.5.12%2520Manage%2520Seismics|4.5.12.1%2520Manage%25203D%2520Seismics|4.5.12.1.1%2520Copy%25C2%25A0Cube|_____0
https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#survey/manage/manage_seismics/manage_3d_seismics/merge_files.htm%3FTocPath%3D4%2520Survey|4.5%2520Manage|4.5.12%2520Manage%2520Seismics|4.5.12.1%2520Manage%25203D%2520Seismics|_____2

1.1.3.5 Export Wavelet To Petrel*

Writing wavelets directly to Petrel* data store is available in various OpendTect win-

dows by choosing EPetre/Direct output format.

Click on Select button to choose an output Petrel* folder, otherwise the data

is written to the first appropriate folder.

*is a mark of Schlumberger.

-70 -



1.1.3.6 Export Well to Petrel*

Petrel well data (deviation survey, time-depth model and logs) can be accessed in

OpendTect by clicking on PetrelDirect insert icon %‘ in the following place:

* Export Well window (Survey > Export > Wells> PetrelDirect*)

The Select Well(s) window allows to select wells from OpendTect project and create a

copy in Petrel*.

) Export Wells to Petrel — O *

] — 0-

Input Well |[J F02-01_ImpNarmal
[] F02-1_Petimp_Sing_SelAll

a [ Fo3-2
[ FO3-4
[ FoB-1

=@ [

New Folder Name Putin |Wells w ESelect.._

Q Close

Well Export User Interface
Multiple exports are supported. Different selection of wells and logs can be made.

Use Ctrl+A and Ctrl+Shift+A shortkeys to select/de-select all items in the list.

*is a mark of Schlumberger.
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1.1.3.7 Export Pointsets and Polygons To Petrel*

Petrel pointsets (polygons) can be accessed in OpendTect by clicking on PetrelDirect

inserticon % in the following place:

* Export Pointsets (Polygons) window (Survey > Export > Pointsets/Polygons>
PetrelDirect)

Export Pointsets (Polygons) window allows to select pointsets (polygons) from

OpendTect project and create a copy in Petrel*.

¥ Export PointSets to Petrel — a x
a - Filter [*

Input PointSets/Polygon |[] 3D Body ~ | B

[J 3D body

E [ Chimneys no v ]
[[] Chimneys yes E
[ FFST
[ gas

[ [ Inner points crossplot anomaly

"1 NL offshore outline "

Base Name I

New Folder Name | ~| Putin | Seismic v EBselect ..

Qoo @

Pointsets Export User Interface

Multiple exports are supported. Different selection of pointsets (polygons) can be

made.

Use Ctrl+A and Ctrl+Shift+A shortkeys to select/de-select all items in the list.

*is a mark of Schlumberger.
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1.1.4 Link OpendTect and Petrel* projects

1. Open both Petrel and OpendTect applications, Select the project/survey you want to

transfer data to/from:

1 O\PetrelData\F3_Demo.pet

2 0N \Cloudspin_SecondaryProject.pet

3 O\PetrelData\Teapot_Dome.pet

4 O\ \PetrelData\F3_Demo_with_wells.pet
5 C\.\Validated_Well_db.pet

H Save project
ll_é Save project as . ..
1 I ]%pen project...

IFPDPE

@ Survey Setup and Selection

‘ﬂSumay Data Root ‘ |C:\Sumays |

Coudspin_Petrel_tst2del EO.L,:‘I
F3_Demo_2016_training_v6 NewSurvey_from_Petrel
F3_Demo_2020_training_v7
NewSurvey_from, Petrel 7504300 750/1250
Petrel_Link_test_2del

Cil o FERCASTY

100/300 100/1250

»~
2. At the start, the Petrel connection icon is disabled (in the lower right corner of the

main OpendTect window).

3. Enable the Petrel connection (drop-down menu next to the PetrelDirect icon):

=N

) Enable
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Y

When the connection is enabled, the PetrelDirect status button becomes active:

4. Initialize Petrel connection (drop-down menu next to the PetrelDirect icon):

|~
Disable
Initialize now

When the connection is initialized, the PetrelDirect status button indicates that the con-

nection has been established between Petrel and OpendTect projects, thus: E

Note: If the connection is enabled and left uninitialized, the PetrelDirect status will

become active once Petrel is used.

*is a mark of Schlumberger.
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1.1.5 Settings Window

Petrel* connection settings can be set/modified by clicking on PetrelDirect status button

E'(Iocated in the lower right corner of the main OpendTect window).

‘e Petrel connection settings — O >

Link status [Active)

TCP port to use

Disable connection on error ® Yes (O No

Enable connection at startup ® Yes O Mo

(] Maximum packet size (bytes) 2000000 >

[ thplyt}] | Qciose | @

Link status: the icon shows the status of connection to Petrel* and can be clicked on to

changeiit:

E - disabled (click on it to Enable connection)

E - uninitialized (connection is enabled, i.e. will be activated once PetrelDirect is

used; click on it to Initialize now or use drop-down menu next to it to Disable con-

nection)

E - active (click on it to Disable connection)
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TCP port to use: TCP port number must be the same as the port number specified on

the Petrel* side. The default value of 57375 should work in most cases.

The default value of TCP port can be changed using DTECT_PETREL _

PORT environment variable. In doubt consult your system administrator.

L

*is a mark of Schlumberger.
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1.2 Basemap

OpendTect’'s basemap is accessible from OpendTect’s main menu (View > Basemap)

or this shortcut icon (%). A separate detached window is launched, which is by

default synchronized with the 3D scene. We recommend turning such synchronization

off if the data size (e.g. area or number of 2D seismic line) is huge.

Basemap comes with its own tree allowing an independent control of data displays. An

overview of the basemap window is given below:

ol =

|
]
3
L

i

£ SMullAl bar

KR S

Main Menus

Basemap

This includes:
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Save (D ) or Save As (ﬁ| ) are used to save the current displays as a map for future

use. We highly recommend saving a basemap on a routine bases. Multiple copies of

the map are also allowed.

¥ Save Dasemap Dala o =0 E =)
salazl prput Hassraz Lata

Filker *

FESO

Mems Eusernap Daom 4 TAT Klap Ok Al 13, 3701E

CO5 ][ @t | @ |

A previously stored basemap can be retrieved using the Open ('a') icon. You can set

one basemap as a favourite /default item (}{ ). If set, the selected basemap will be

opened every time a new OpendTect is started.

Sl BmepData o | et

Snw npd Bassimap Maae

Fil=y

| Rssmrreapy Msrmsa A TWT S 1M &gl 12 716

—
]
.

]

[ @ || ©Ounca |[ groe |
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The settings sub-menu is used to change the outline style (line pattern, thickness, and
color) of the current basemap. The default background color is white, which can also be

changed, if needed be.

Survey Outline Style  Detted v Color | [ | Width 1 =

Background Color | || wmits -|

[ Qo ][ Oca |

Processing

Filtering: A selected horizon grid can be filtered within the basemap. Median filtered is
preferred if you intend to de-spike a horizon grid. Average filter is considered as a gen-
eral smoothing filter. If you intend to display the resultant grid then check the Display

after create option.

g e BCIS
invalid Horizon [ Damo 1= MFS4 -
Filtar typa @ Median | Awerags
Filter stepout inl2 0 cd2 =i
Save Horizon (@ As new Ohervirite
Output Hosizon Dama 1= MFS4 MF2x2 ~ | © select || G -

| Display after create

[ Orn || Ocose || @t
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Gridding: OpendTect supports several gridding algorithms (For details refer to 3.7.3.1
Grid in OpendTect User Documentation). The supported parameters are summarized

below:

* Scope: This is used to control the exterior geometry of the output horizon. Con-
vex hull is mostly used, which automatically creates polygon (hull) using the exter-
ior data points of a given horizon and creates are horizon within this polygon.

* Inl/Crl Steps: This option defines the output grid spacing. Often the seismic sur-
veys are defined with an average spacing of 12.5m or 25m as a step. For larger
surveys, we recommend under-sampling the output grid to 2 by 2 or even 5 by 5.

* Keep holes larger than (m): This option is used to keep larger holes in the sur-
vey. The gridding algorithm will not interpolate the areas larger than the set size.

* Algorithm: Several gridding algorithms are supported (For details referto 3.7.3.1
Grid in OpendTect User Documentation). Some of them use the fault e.g. dip
steered gridding algorithm (requires 3D seismic).

* Search radius (m): It is mostly a best practice to include a part of data points
within the search radius. For instance, if 2D lines are evenly spaced at 2000m
and most of the lines have been interpreted, then the search radius should

approximately be 2000m or larger.

-80-


http://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#opendtect_trees_and_elements/horizon/tools/grid.htm
http://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#opendtect_trees_and_elements/horizon/tools/grid.htm
http://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#opendtect_trees_and_elements/horizon/tools/grid.htm
http://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#opendtect_trees_and_elements/horizon/tools/grid.htm

Horizen g Demo 1 = MFS4 * | B Select ..

Seops | Cormex: bull -

InliCd Step 1 1

| Kzep hales larger than {m})

Algarithm :rme distance *]

Faull - © Seect .. || Clea

Search radius (m) Faramaiers . |

Save Hanzran (@) As new herverits

Cuipul Hanzon - [ O Select .| | duB -;

| Cizplay sfter create

Eﬁun I ) Close H_ﬂHalp |

Synchronization

Data displays can be handled from the basemap. This is done if the synchronization is
turned off/on for specific items. At present, the synchronization is set globally between

the basemap, 2D Viewers and 3D Scene.

If it is turned ON, then the data will be displayed in 3D as well as in 2D Viewers - if

launched.

Contrarily, if the sync is turned OFF, you can display on an element from the basemap

toa 3D scene /a 2D Viewer. This is done via the right-click menu.
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For larger 2D surveys, it is recommended to turn off the synchronization

between the 3D Scene and the basemap. This will avoid memory con-

L

sumption issues and instabilities in large data displays.

Help

Itis a standard help button pointing to this documentation.

Trees and Elements
Inline, Crossline and Z-slices

These elements are added in the tree through a right-click menu. The position of the
element (Inline and Crossline) is selected by clicking on the basemap. If the syn-
chronization (via the Main Menu) between the 3D scene and basemap is turned ON,
the inserted inline will be visible in the 3D scene. Dragging of the elements will not only
change the position of the lines but also interactively update the 3D scene if the data is

preloaded.

= Hasemap - Soenel
Basemap Prooessng  Smcuiezanm kel

Y o

Hagsrap: [1ss =]

i A
Elrmenie lalnr !
H Satarm M

d || i n-haey
H o | ~Chih ss Bascvap-
o sl
- = | =Ghakan Basemap
sl el
ol = i Cobe Cutire
b= «| ~ FRaredam Liné
— ¥ wr

This is an example screenshot of adding an Inline element in the basemap. Note the

label along with the tool tip for guide. The same implies for the Crossline.
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If a Z-slice is added, it will show the following dialog to sub-select the area of the z-slice.

By default, the values will be the survey range.

% Select Hasernap parameters = || @ | B2
Ingrul Diatas |4 Dip steered medsan filter || B select .. |
rHine Hange 100 = - 1" =
Cross-ing Range 300 = 130 2
7 (m) w220 |2
| @ok || © Cancet

It adds z-slice in the basemap with a given range.

Z-slice also has a right-click menu (tree > z-slice > right-click) containing several
options. The properties option will show the positioning dialog to reposition the slice.

One can also show the z-slice in a 2D Viewer or in a 3D scene via the right-click menu.

If you intend to add a z-slice in the basemap, we will recommend preloading
the data as the seismic data visualization along these slices could be

L

slower.

Alternatively, you can also add inline at a mouse position. This is done via the right-click

menu:

A
M

Ak Ie-hmp
A Crast brey
A |e-Ead and Crosding
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Cube Outline

This element displays an outline polygon for a given cube.

Random Line

New Lines

In the basemap, random lines can be created as a group or individual sub-elements.
Once an individual random line is added in the tree, a user has to click on the basemap
to draw its geometry. Once finished, double click to confirm the geometry. The geo-
metry can be manipulated by dragging the line nodes on the basemap. If the data is pre-

loaded, the random line will be interactively displayed in the 3D scene.

Furthermore, one can drag/rotate the line in the 3D scene. Its geometry will be updated

in the basemap and vice versa.

Random lines can also be launched in a 2D Viewer to perform interpretation (within the

basemap, right-click on the line and choose 2D Viewer).

Like other elements, random line also has its own right-click menu giving a flexibility to

manage the element.

7] ¥ Cubs Outling
d | '~ Random Line

Add
[¥] <Random Ling
o 20 Line Naw
7 & 30 Honizon Create Croup
| W Contour Properties
| -4 70 Honzon Shigw
o £
o \ FauHShckSet Hida
o | & Wl
5 Ve Rexrmizee All
M| ot PickSet
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Random line right-click menu

e cole | | eRau A =
T - TN

Random line properties
Add Existing Lines

Pre-existing random lines are added using the Random Line > Add right-click menu.
When multiple lines are selected a common property (such as line color and line width)

is set to all selected lines.

- File *

7 iwalscoredon -
Fl4

[7 a0k

I Cyclalan

W ExGEznz

W Aoz

I Lxzmpl: rardzm cosloor dzmz 1 = Wl S
R a2 e) cam

R razia cam i

W raadruzs

[ Hezlngpraze

[ Inpefa Lnz2 FUZUE ozaon

7 rditivd= 55emnm

Fl 1 | B

[ B4 [

Linmcolor | I Wiath 1 [

L@ ][ O cmen |

Add selected random lines in the basemap.
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l = Lo =
Chsek all (Cirl-&) _
Ll Uncheck all {2 & b
Il sodliac o I-ﬁ.
= R webection lﬁ
=

| Fi2F03_Cor
o FIE-FO3 Coer N
| FillaFiza
T Heslingphasa
npalE_Lingd FIG-07 kscatan
Euhrde-Sirmen -
4 1 ¥

Ling cohor Widh 1 —

This image shows how to Save selection for future use. Using the same method, one

can retrieve the selection by selecting the Read selection option.

Grouping

Random lines can be grouped (Basemap Tree > Random Line > Create Group). In
each group, a new random line can be created or an existing random line can be inser-
ted. Sub-groups can also be created using the right-click menu.

To rename a group, double click on the newly added group name.

4 |~ Random Ling

W ~ [EWLlines |
[# & 20 Line
[ 4 30 Hosizon

For the time being, basemap does not support saving of the groups. If you

have grouped the random lines in the basemap, we recommend saving the
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basemap so that you can retrieve the current layout and settings else the

set grouping will be lost.

2D Line

2D lines can be added on individual basis or as a group. The latter is preferred if you

are dealing with multiple seismic vintages.

If you intend to add many 2D lines in the basemap, we recommend turning
the synchronization off between the basemap and 3D Scene. This will
speed-up the displays and will give you a freedom to choose what to display

in a 3D Scene.

Add Selected Lines

Selected 2D lines can be added in the basemap via the right-click menu (Basemap
Tree > 2D Lines > Add). For future use, you may save the selection using the menu
available at the top level (a drop-down arrow). This is identical to saving a selection list

for the random lines (as mentioned above).

Common line properties (line color and line width) are set to a given selection.
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&
2
g
=

Multiple selection of a list of 2D lines.

fel e =

i

:

Z

] »
> 84 ([

Save selection for future usage.

Grouping
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2D lines can be grouped per vintage or as you like. A group contains a list of selection

that can be extended at later stages.

If grouping is done in the basemap, we recommend saving the basemap for future use.

Basemap Tres &
Elemants Color =
¥| ~ Random Line
4 || 7 2D Line
4 [V 7 71 Lines -
V] TIW-17 -
¥ T1w-18 (]
7| TIW-21 -
¥ Tiw-22 [
W TIw-23 -
W] TIW-24 -
4 |7 7 72 Lines
V| T2W-01 [
¥ 72wW-03 -
4 [ 77 80 Lines
¥ 80w-03 (| L
7| 80W-04AB . 1

An example structure of grouping a set of 2D lines.

A 2D line group has its own right-click menu to manipulate the displays. Most of the
options are self-explanatory. Highlight is the only option that could be used for QC pur-

poses, which highlights the 2D lines on the basemap that have dataset.
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4 [F] 7 20 Line
— — Create Group
W B0 Lime
Renaime
o 54 <
opaitias
7] = 88 Line e
W 84 Limg Show
v [T Groupi Hide
¥ 7U84-03A Remave All
¥ ZUB4-B4  ww Remove from Tree
» | FRT5-36
¥ FR85.13 Highlight

2D Line grouping and a right-click menu.
Properties

Line properties can be changed at a group level or at an individual level. Only line color

and line width are currently supported.

Sl Bamap paranieers ;IEE

necohsr [ | ‘s 4 =

CQo ] [ Qo]

Displaying a 2D Line

A 2D line can be displayed in a 2D viewer or in a 3D Scene. Traditionally, the 2D lines
are displayed in a flat viewer such as 2D Viewer in OpendTect. This is done via the
right-click menu on the basemap and choosing Show in 2D (as shown below). In such a

viewer, one can perform seismic interpretation and continue working with the basemap.
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3D Horizon

A color coded horizon grid is displayed in the basemap via this tree item. Attributes com-
puted on a horizon can be displayed as horizon data. To add one or more horizons, use
the right-click menu from the basemap tree (3D horizon > Add). The color table of the

horizon grid can be changed from the color bar shown in the top toolbar (by default).
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' Add 3D Horizon

Horizon

"

Fiter *

=Demo 0 —>F54 <
Demo 1 —= MFS4

Demo 2 —> FS6

Demo 3 —> Top Foresets
Demo 4 —> Truncation
Demo 5 —= FS7

Demo 6 —> FS8

Demo 7 —=> shallow

11

Display () Z values @ Horizon Data

Horizon Data

Similarity [-28,28]

Spectral_decomp 64Hz
Spectral_decomp 44Hz
Spectral_decomp 24Hz

| @0k ||© cancel|

If you intend to add large number of horizons in the basemap, it is recommended to turn

of the Synchronization with 3D (via the Main Menu > Synchronization).

7] 15 20 Line
¥ | % 10 Horizon

+|lDemo 3 " "
| W Conlour Shew n 30
| —4 20 Hong Show in 2D
o Fauti=tn Filtarimg
7 A Wl Gridding
W PiekSel Remoe
o ]:} Podygon
7| [ image
| HF Annctalion

Show in 3D/2D: Shows the selected horizon in a 3D

scene or a 2D Viewer.

Filtering / Gridding: Each horizon can be indi-
vidually filtered or gridded by following the right-click

menu or from the main menu of the basemap (see

under Processing).

Remove: Only removes the horizon display from the

basemap.
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Note that the order/overlay of the horizon display in the basemap is according to their

Z-values (m or ft).
Contour

Contoured display of a horizon grid can be added using this tree item. The following win-
dow shows the contour range, contour step, and line properties for a selected window.

By default, contours are plotted on top of the 3D horizon.

'Ei." Select Basemap parameters | = | (=] | >
Filtar *
Demo 1 == MFS54 &
Demo 2 —= FSE E
E.l Demo 3 —> lop Foresets
— | Demo 4 —= Truncation :l
Demao 4 —» Truncation trim & fill
Demo & -> FST
Demo & —= F38
| Demao 7 —> shallow -
Contour range (ms) 400 1200 Step 50

Line color | I | Width 1 ]
QG’:{ | ) Cancel

After the display, you can change the contour range/step by right-clicking on the con-

tour item in the tree and choosing the properties option.

2D Horizon
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Since version 6.2 2D horizons are displayed as color-coded lines. Grouping feature is

also supported for 2D Horizons.

Fault Stick Set

Fault sticks are projected on the basemap and hence may show the spatial location

and extent of the fault.

Eﬂ&elect Basemap parameters| —1 ” (=] |u
Line color |- | Width 1 =

£ Intersection {ms) |0 . Dhsplay Projection

| QDI{ l ) Cancel ]

Fault stick properties

FaultSet

The FaultSet is supported in version 6.6.0 and can be displayed in the basemap.

The following shortcut can be used for drawing a polygon in basemap: CTRL+Z
CTRL+Y.

Properties can be set for both pointset and polygon.
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Well

To add one or more wells in the basemap use the right-click in the basemap tree. Just
like other elements (e.g. Random lines / 2D lines), wells can be grouped by creating a
group and adding a set of wells in it. If you intend to create such a thing, we recommend

saving the basemap.

Well properties allow you to control the well symbol, size, and projection.

a [ R Exp—— % St R parasters (= e =50
- fudd
?l FO2- Tl parabels &l Ticw 1 T | Dmzwy Mapchon
¥| Fo3-2 Creale Group m
o Fo34 Ranama sl
| FO&-1 : i Qo[ O e
7] 5 PickSal e ] :
Zhow aryhols =
o D Ilnll"g'm . plezoecndvnl
o m Imags Fida ﬂ siupgpesh s |
v 4E Aot at Feamove &)1 Pl vl
o e hoe 0
== e Fom Tees ) cancsrdacrs

Well properties — Display projection to see the well trajectory.

Pickset

This element is reserved for displaying a point (or pickset) data in the basemap.

Polygon

This element is reserved for displaying existing polygons or creating new polygons in

the basemap.
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Name for new Polygon

@ Create New Polygon = [g]

Color ‘E l m Peru

Depth for Picks [Seconds

| @OK || @ cancel| | @Hep |

Shapefile

Allows adding shapefiles to the basemap.

) Add Shapefile —

[] = Filter | *

[] slump-2ab
[] Slump-2b
[] Slump-2c
[] Slump-3
[] Slump-4

[ ] Slump-5
[] slumps-1

Line color | [ Width |1 =

Qm{
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Image

An image (PNG, JPEG, XPM, or BMP) can be added in the basemap. Its coordinates
have to be properly added to position it at correct level. An image can have borders,
which may not position the image correctly. You can use geo-reference (e.g. QGIS)

tools to measure the actual coordinates of the image.

NorthWest (TopLeft) Coordinate 605381 0548195 6090463 1688065

SouthEast (BottomRight) Coordinate 623576.25771336 6073556.36221996

[ @K ][ © cancel |

Annotation

To add grid lines on the basemap, this element is used. Grid lines and their annotation

can be based on inline / crossline steps or XY spacing.
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https://www.qgistutorials.com/en/docs/3/georeferencing_basics.html

Grid system () Inl'Crl @) XY

W Show X lines:
Spacing (Start/Stop) &10000 625000 Step 5000 Crop to Survey Box
' Show Y lines:
Spacing (Start/Stop) 6075000 6090000  Step 5000 "] Crop to Survey Box
Line style |Solid -| Color [ NENEEN | Wicth 1 [

Qo ][ ©cance |

Toolbars
Main (Top) Toolbar

This toolbar appears (by default) under the main menu of the basemap. It contains the

following icon:

“ Shows the selected item in a 3D scene.

“= Removes selected items from the basemap (and/or 3D scene if sync is ON).

General Toolbar

Open a stored basemap setup.
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|

B Save the basemap.

m Save the basemap with a new name.

ﬁ Take a high resolutions snapshot of the basemap.

rm L
'¥=J Prints the basemap on a larger scale (e.g. PDF of A0 size).

e

n Show or hide the North Arrow in the basemap.

“*= Show or hide the scale bar in the basemap. Scale bar also has settings next to it

(small arrow) to change the width of the bar.

n Show or hide the color bar in the basemap.

=
lﬂ'_l Show/hide the legends in the basemap. Note that this item is editable (click on the

text to change it). It can also be freely moved and placed at a desired location on the

basemap.
'E? Selects data within the polygon e.g. horizon.
ﬂ Removes/deletes the selected data.

Color Tables

Color tables are linked to 3D horizon grids displayed in the basemap. You can flip the

color bar values, clip the range, or manually fill in the numbers.

I:I ﬁ??a}:in A OTENT T I e sl T -
Flipped

Hanges/Clpping -_. I
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Title and Printing

Basemap title appears within the basemap. This field is editable (single click on the text
and start editing). We support two ways of printing the basemap. The first one is via the
Screenshot method, where you can take a high resolution image of the current map.
The second one is via the print icon, which allows you to change the orientation (e.g.

landscape), and output printer (e.g. PDF if installed).
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1.3 PDF3D

The PDF3D functionality has been expanded to include the option to export the 3D

scene to a 3D viewing format called gITF.

Scroll down to view the possibilities for this option.
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PDF3D

The plugin allows you to grab a 3D scene in OpendTect and store this in pdf format.
The file can be opened in the free Acrobat Reader, or embedded into a Powerpoint
presentation. In Acrobat Reader (v8 and higher) you can view, rotate, zoom, toggle ele-

ments on and off, and otherwise manipulate 3D graphics.
Currently supported objects include:

* In-line/cross-line/z-slice
e 3D, 2D horizons

e 2Dline

* Well data

* Fault

* FaultStickSet

* Body

* Random lines

* Top/Bottom Image

¢ HorizonCube and SSIS models*

* PointSet/Polygon. Multiple pointset shapes such as cylinder, cone and cube. If a
shape is other than these just listed, it will be converted to sphere. These shapes’

size is dependent on the size of the pointset displayed in 3D Scene.
* ColorBar
* 2D Seismic Line is now shown.

*requires HorizonCube and SSIS commercial plugins
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-
To create the file click on PDF3D icon ‘& . This will open a pdf file containing all the

elements displayed in the active scene and will automatically save it to the Misc folder

of the project.

s

4
=ave 30 scene as POF ..
mave 30 scene as gITF .

Save scene as option will first bring a window where you can choose the desired path

for the pdf file and the name, select horizon resolution and set a password if necessary.

@) Save scene as 3D PDF — O X
Select horizon resolution Half v

[ ] Password

Output File name _Mar_2021-10.55.38.pdf ) Select ...

&OK | €3cCancel (=)

The 3D toolbar contains several icons to manipulate the scene. You will find more

information on the Adobe website.

Please note: It may be necessary to give Adobe permission to display the 3D content,
as in the following image. Use the Options drop-down to trust the document either once

or always:
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https://helpx.adobe.com/acrobat/using/displaying-3d-models-pdfs.html#3d_toolbar_overview

@ Multimedia and 3D content has been disabled. Enable this feature if you trust this document.
S

(=

Toggle on the Model Tree icon == to display show a list where you can see

the names of the scene elements and toggle them on and off. Decreasing of
. the Framerate Threshold to 4FPS will help to avoid blinking of the elements

while rotating or repositioning. To do so, right-click on the scene > 3D Prefer-

ences > 3D and Multimedia Category.

For optimal viewing in Adobe Reader (v8 and higher) we recommend the following:
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* Run Adobe Reader (not embedded within a browser such as Internet Explorer)

* Click on the menu Edit->Preferences... to pop up Preferences dialog

* Select under Categories: (box on left) 3D and Multimedia

e Turn on Enable double-sided rendering in Renderer Options box

* If the scene is not too large then you might wish to change the Optimization
Scheme for Low Framerate from "Bounding Box" to "None" in the Auto-Degrade
Options box. Alternatively you might wish to continue using Bounding Box but
reduce the Framerate Threshold from 15FPS to 1FPS.

Furthermore, we recommend viewing directly in Adobe Reader and not as a plugin to a

browser. Toggling elements on and off is easiest if you use the tree.

It is now possible to toggle between horizon intersection lines with Seismic slices and

full display of horizon (called Surface in tree item):
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Model Tree X

(&

@
o model

E s g OpendTect Scene -- dGB
v Horizan: Demo 0--= F54

= -M highiight color ~

[ Intersectionline

[ Surface
[ Fault s
[ PointZet 1000 between FX
[ Well: FOZ-1

o Wl FO3-4

>

>

>

3 [gg Well: FO3-2
>

3 [gg WWell: FOE-1
>

[ Survey box
[ In-Line: 425
[y Cross-Line: 775
[ Z-Slice: 924

In case the model tree is not visible, it can be toggled on from the E button in the

sidebar.

Note: Currently supported items in PDF3D should not include the ColorBar as it can

not be toggled off from within the Adobe reader.

System requirement (macOS)

macOS needs to have the XQuartz application installed for PDF3D to load. XQuartz
can be downloaded for free from their web page. XQuartz is a 3rd party application, and

dGB Earth Sciences should not be held responsible for the performance of XQuartz.
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gITF

The files produced in this format can be viewed on the native Windows 3D viewer, avail-

able in Windows 10 & 11. These files can also be viewed online.

This option can be accessed via the PDF3D Tool Button (or from Scene -> Save
3D Scene ->gITF...):

Save 30 scene as PDF ...
Save 30 scene as glTF ..
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Scene  Wiew Utilities Help

Mew

Mew Map View

Mew [Depth] 4

Mews [Horizan Flattened] 4

Mew [Wheelar] 4

Cascade

Tile 3

Properties ...
“% Sawe 3D scens ’ FOF ..
v Seens glTF ...

On selecting to save as gITF, the following dialogue box appears, allowing the user to

specify the resolution and to set the output file location.

% Save scene as gITF — O X

Select horizon resolution Half v

Output File name _Mar_2021-10.57.09.glb| ) Select ...

0K | €cCancel ()

The default location is in the Survey\Misc folder.
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1.4 Thalweg Tracker

provens

S

Channel
lobe ¥’

-

.3; n’

Introduction

This plugin tracks seismic facies such as channels and reefs. It outputs either horizons

with a set of tracking attributes, or 3D objects, or Pick sets.

A Thalweg is a geologic term to describe the path of a river as it flows through a valley
(Thalweg is a German word; Thal means valley and Weg is path). A Thalweg tracker

operates in a similar way: the tracker follows the path of least resistance.

The Thalweg tracker is a special form of a voxel connectivity filter. Based on certain
user-specified constraints, It tracks neighboring samples in an input seismic cube. Ini-
tially the user picks a single seed position. The seed is considered to be a cube of unit
size and the next sample to be tracked is chosen from all available samples along the
‘faces’ of the seeds. In the first iteration, all six neighboring samples along the six faces
of the initial seed act as candidates for tracking. Only the best matching position (i.e.
the highest, or lowest amplitude) is added. In the next iteration, all samples neighboring
the two currently accepted positions now act as candidates and again only the best
matching position is added. This process continues until it is no longer possible to add

candidates that meet the tracking constraints.
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A Thalweg tracker adds only one position per iteration. If you choose to accept more
than one position per iteration, the Thalweg tracker becomes a margin tracker. Thal-

weg and margin trackers are typically run sequentially.

The output of a Thalweg tracker is a Point Set that can be saved as "snapped" horizon
(parameter window), or it can be saved as a 3D body. or Pick set (3D scene, right-click
on the object). When it is saved as a horizon all tracking attributes will be saved as Hori-
zon data with the horizon. The tracking attributes can be used for further analysis in the

Crossplot tool.

Menu
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‘(}% Thalweg Tracker - O X

2E%E
Input cube *&, | DSMF_depth ~ | ©) Select ...
Area subselection ‘425/300-425/1 250 (463 samples) ‘ ©) Select ...
Start Position (Inl/Crl) | || CZ(f) & Value:

Event to track ® Minima O Maxima

Min Threshold | Max Threshold | ' [ Use Layer Constraints

Amplitude Scaler ‘1 | Amplitude Sum Scaler ‘1
Schedule Max Nr Cells Cells per iteration Cut-off criteria Cut-off value 1_
111000 =1 * INot Applicable - 0.000 2 -

Track View log ...

Show Points |[Display Settings ...

Output horizon ‘ v ‘ © Select ...

Snap to event; Search gate (ft) -9 ‘ ‘9

Create horizon

Output cube | | ©) Select.. @ICBVS v

Create cube

@ | @ ®

Input cube: This is the input seismic (or attribute, impedance, ...) cube.

Area subselection: The tracking area (or volume) can be constrained using one of the

many available criteria, viz. Range, Polygon, Horizon etc.

Start Position (Seed): This can be picked interactively with the green arrow. The

picked amplitude is displayed immediately after picking.

Event to track: Samples can be tracked either on maximum, or minimum amplitude.
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Thresholds and Layer Constraints: The automatic values for min and max
thresholds are estimated from the picked position. These values can be overruled
manually. When the Layer Constraints toggle is on the software will not allow a body to
grow on traces where the body already exists. This (default option) prevents tracking

multiple forks of an event.

Amplitude Scalar: This optional scalar is applied to the Amplitude attribute output and

can be used to improve visualization.

Amplitude Sum Scalar and Amplitude Sum Step: The optional scalar is applied to
the Amplitude Sum attribute output and can be used to improve visualization. The
Amplitude Sum Step is the re-sampling rate that is used to compute the Amplitude Sum

attribute (see Display options).

Schedule: This is the control center of the tracking process. The idea is that objects
are tracked in one, or more sequential processing steps. Steps can be added with the
green plus and red minus icons, respectively. Each step has its own parameters. Typ-
ically, the first step is run in Thalweg tracking mode, which means that only one cell per
iteration is added. Only the best matching cell (the lowest, or highest amplitude of all
neighbors) is added. In following steps the constraints can be lowered. More cells are

added per iteration. This is the margin tracking mode.

A typical work flow is the following:

* First the Thalweg tracking mode is used to track a channel.

» Start by tracking a large number of positions. Let's say Max. Number of Cells is
set to 20,000.

* Examine the result and observe (from the iterations attribute) where the body left
the first Thalweg and spilled over into the next Thalweg.

* Re-track the object from the same seed position but now use a smaller number of
points that will track the object until it reaches the spill-point. You have now found

the first channel patch.
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* To track the channel margins add another layer of let's say another 20,000 points
but now accept more cells per iteration and accept more points than the best
matching only.

* Save the tracked patch as a horizon.

* Repeat the process from another seed position and merge the patches (merge

icon at the top of the window).

Max. Nr cells: This is the maximum number of cells that the body can grow with when

Track is pressed.

Cells per iterations: This is the maximum number of cells that will be added per iter-
ation, i.e. each time the neighbors are evaluated and the body grows. If set to one the
tracker runs in Thalweg tracking mode. A value larger than one means margin tracking

mode.

Cut-off criteria and Cut-off value: These constraints control which cells are accept-
able when tracking in margin mode. A percentage cut-off of 5 means that the highest,
or lowest 5% of all possible neighboring values are eligible. Out of this group the best
matching cell is added first, followed by the next best and so on. This continues until
either the number of cells per iteration is reached, or there are no more cells in the pool
of eligible cells to add. The standard score criterion operates in the same way. The eli-
gible neighboring values are the amplitudes above, or below the mean value of the
body plus, or minus the number of standard deviations given in the standard score cut-
off.

Track and View Log ...: Press track to actually run the tracker. Only the last step is pro-
cessed. The output is shown in the 3D scene as a point cloud (left image below). Note
that the point cloud is not saved! This is an interactive process. Play with the para-

meters until you are satisfied. Only then save the results: either as a horizon (right
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image below), or as a point set, or 3D object (in the 3D scene). Press View log to see

the processing log file that prints statistics after each iteration.

Display and Output options

.’ —_—
o et Point c
/.» -

loud./"30'hody

*'1"} Display Properties — 0O 4

Attribute to display |Iteration M

Z
Schedule 999 i1 Rainbow -

Cell Number
Thickness
Amplitude Sum
Amplitude
Average
StdDev

O Apply| © Close

Attribute to display: Two sets of attributes are computed by the Thalweg tracker: Pro-
cess attributes and Body attributes. The Process attributes tell us how the body and its
properties grew from the seed position. Attributes in this group are: Schedule, Iteration,

Cell Number, Average and StdDev. Schedule corresponds to the processing step in
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which the cell was added to the body. Iteration returns the iteration step that was
reached when the cell was added. Remember that in margin mode more than one cell
is added per iteration. The cell number is the sequential number assigned to the cell as
the body grows. Average and StdDev are the running average amplitude and the run-
ning standard deviation of the amplitudes. These statistical properties vary as the body

grows.

The Body attributes are: Z, Thickness, Amplitude Sum, and Amplitude. Z is the depth of
the cell in 2WT, or depth, as the case may be. Thickness is the vertical thickness of the
body. Amplitude sum is the vertical sum of the amplitudes computed from interpolated
amplitudes with the user-defined sampling rate given in the Amplitude Sum Step field.

Amplitude is the amplitude of the cell.

Output Horizon: The tracking results can be saved in the form of a Horizon. Typically,
the horizon will be snapped to a maximum, or minimum event that is found within the
user-defined search gate. All attributes will be saved as Horizon data with the new hori-
zon. If the horizon was snapped, the amplitude attribute will return the amplitude of the

shapped event.

Output 3D Objects, or Pick Sets: To save the results as OpendTect Pick set, or as
3D obiject, right-click on the point cloud in the 3D scene and use the corresponding

menu option.
References:

Pelissier, M., Changhua Yu, Singh, R., Qayyum, F., de Groot, P. and Romanova, V.
2016. Thalweg Tracker: A Voxel-Based Auto-Tracker to Map Channels and Associated
Margins. EAGE 78th EAGE Conference & Exhibition, Vienna, 30 May - 2 June 2016.

See also the pdf, and/or video recording of the oral presentation.
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1.5 Advanced Ray Tracer

The full article can be found in the user documentation under 5 Analysis > 5.5 Layer
Modeling > 5.5.1 Basic > 5.5.1.2 Synthetic- and Property-Log Generation > 5.5.1.2.3
Ray Tracing.
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1.6 Horizon from Well Markers

The tool is utilized for creating 3D horizons from well markers using Radial Basis Func-

tion gridding.

If need be, 2D horizons can be later derived from the 3D ones using Create

from 3D option.

Select markers from one or more wells

Markers - Filter |*

W F51 |
Fs1

Fs2
Fs53
FS4
F&&
F&7

Wells - Filter |*

FO2-1
Fo3-2
FO3-4
FOB-1

C

X

Area subselection |- | © Select l

Trend Polynomial |Gfder1 :

Display after create @ run [ Q) Close I
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http://www.scholarpedia.org/article/Radial_basis_function
http://www.scholarpedia.org/article/Radial_basis_function
https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#opendtect_trees_and_elements/horizon_2d.htm
https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm#opendtect_trees_and_elements/horizon_2d.htm

Selecting more than one markers will result in creating several horizons at a time. The
output horizon will be saved to the database under the name Horizon From *selected

marker®.

Trend Polynomial: Trend processing must be applied during gridding using Radial
Basis Functions. The order of the trend removal may influence more or less the res-

ulting 3D horizon:

None: Disables trend removal processing.

Order0: RBF gridding with average removal

Order1: RBF gridding with linear trend removal (default)

Order2: RBF gridding with parabolic trend removal

The resulting output horizon depends largely on the lateral distribution of the control
points (the wells). Try and choose the best parameter for the Trend Polynomial based
on the most realistic result, as it is not possible to state which order will return the most

reliable horizon.
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1.7 Well Table

@ Well Table - O X
';lr (f [A s E \% () Selected zone |<Start of data> v| |<End of data> " Domain |MD -
Well name Uwr X (m) Y (m) TD (m) KB (m) GL (m) Density Sonic Gamma Ray
F02-1 F02-1 606554.00 6080126.00 1695.00 30.00
F03-2 F03-2 619101.00 6089491.00 2140.00 30.00
F03-4 F03-4 623255.98 6082586.87 2048.00 34.10
F06-1 F06-1 607903.00 6077213.00 1701.00 28.64

New tool for well data management, introduced in the 6.6 release of OpendTect. Color-

coded cells and rows show which data in which interval is present.

Log plots and crossplots that use bokeh plotting are available via the corresponding

icons.
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1.8 Create Body

v M [ Polygon
t2
¥ Shapefil
=y Prestacl
Annotations

Display ’
Calculate Volume ...

Close Polygon

Save

EX

Save as

Set as Work Area ...
Change Z values ...
Create Body ... %
Lock Treeitem

Export to Google KML ...
Remove from Tree

|1 O

A body can be extracted from a drawn polygon. A polygon can outline a geobody e.g.

channel, valley, other geomorphological feature, or any arbitrary shape.

The generated volume (body) is limited by the polygon surface area and the horizons

chosen for top and bottom.

Different attributes can be displayed on the body on-the-fly, which in turn can be inter-

preted further.
The workflow is as follows:

1. Create a new polygon that defines a geological shape.
2. Right-click on the new polygon name and select Create body
3. Inthe pop-up window select the top and bottom horizons to define a vertical limit.

Press OK to continue
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The setup will create and display the output body. An example of a body of sand-waves

from offshore seismic data is shown below.

* Create body || (=) | |

Select polygon and horizons

Top horizon Channel-Top ~ | & Select ...

Bottom horizon Channel-Bottom - 6 Select ...

[ ©ox || cancel | @ Hetp |
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1.9 Horizon Mathematics (2D and 3D)

The horizon math (both 2D and 3D) tool allows for utilization of the following statements

and statistics:
e Basic math (+,-,*,/,*)
* Functions (exp, In, sin,...)
* Logical (<,==, &§&, ...)
 Statistical (rand, min, avg, ...)
* Constants (pi, e, undef)
e Other (inl, crl, X, Y)

You can type in any formula and apply any values and mathematical operators and for-

mulas, e.g.: for converting grids from time to depth.

The tool can be accessed from the Processing menu — Horizon Mathematics. Here,

select if you want to apply the horizon math tool on your 2D line data or 3D horizons.

-123 -



@ OpendTect Pro V7.0.3rc5 (Windows) : NZ_Maui-3D - [Scene 1]

©7 Survey Analysis Processing Scene View Utilities TerraNubis Help

£ Al b= G By Create Seismic Output

----------- T Create Horizon Output
. ree scene 1
Wells

- (Re-)Start Batch Job ...
‘ Scene 1
a . In-lir COLOP ...
=
-

Elements
hd

@ W Cros: A M-GS Destriping ...
@ & Z-sli Horizon|
V- @® Volu  Dip Steering

9 @ 7 Ranc &g Faults and Fractures
@7 2DL € HorizonCube

_ @ ®3DHE ssIs

¥~ v @ Horizon_RGB m
7 Contours (Z Values)
® ~ Z values o

Depending on your selection, the Ul for either the 2D or 3D Horizon Maths will appear:

@ Horizon Math 3D - u} X
‘MathFunctions v ‘ ‘sqrt (Square root) v ‘ Insert E
Formula [ SD_low - SD_mid J( st ]
For 'SD_low' use ‘ Horizon_for_SD-RGB_demo v ‘FFI'_[—28,28]ms_StepSHzlfrequency =15Hz -
For 'SD_mid' use ‘ Horizon_for_SD-RGB_demo 2 ‘FFI'_[—28,28]ms_Step5H2|frequency =35Hz -

Save as O Horizon @ Horizon Data

Horizon ‘ Horizon_for_SD-RGB_demo v ‘ [9 Select )
Output Horizon Data | SD_low - SD_mid_output -] [9 Select ... ]
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Above is an example formula. On clicking Set, you can then select which element to
use for names typed in the formula bar. Constants can be designated the letter ‘c’ with

an optional number as the suffix, e.g. c1, c2 etc.

For more detailed information on the Input Parameters, operators, other options and

expressions of examples, please take a look at the OpendTect User Documentation:

entry for the Mathematics Attribute.
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2 Faults and Fractures

2.1 Attributes

FE I Attributes

Filters

% Planes

Tools

% Faults and Fractures 3D Control Center - d

Available Attributes

Fault Likelihood (FL)

Thinned Fault Likelihood (TFL)

Create TFL from FL

Basement Fracture Likelihood

Thinned Basement Fracture Likelihood

Convolve (Edge Enhancement)
Curvature

Dip/Azimuth Attributes

Fault Dip/Azimuth

Fault Painter

Finger Vein Attribute

Fracture Density/Proximity
Gradient/Azimuth of Curvature
Semblance

Similarity

Go ...

Qe | @ O
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2.1.1 Fault Likelihood (FL)

‘(T%‘ Faults and Fractures 3D Control Center - | X

Available Attributes

— . Fault Likelihood (FL)
“:E.,l Aiflizs Thinned Fault Likelihood (TFL)

—e=l Create TFL from FL
Basement Fracture Likelihood
Thinned Basement Fracture Likelihood

Convolve (Edge Enhancement)
Curvature
Dip/Azimuth Attributes
Fault Dip/Azimuth
Fault Painter
Finger Vein Attribute
% Planes Fracture Density/Proximity
‘ Gradient/Azimuth of Curvature
Semblance
Similarity

Filters

Tools

Go ...

(00 @ &

Fault Likelihood is the unthinned version of our Thinned Fault Likelihood volume, which

is used as an input to the Fault Extractor and Thinned Fault Likelihood.

Workflow

To process the Fault Likelihood volume, click on this icon ™ w and select Fault Like-

lihood under Attributes.
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Parameters

% Create Fault Likelihood — O X
Input Cube 5& ‘4 Dip steered median filter v ‘ © Select ...
Volume subselection ‘100/300-750/1250 (463 samples) ‘ e Select ...

@ Advanced Settings

Output Cube v € Select ...

Batch execution Single Process ¥ |4, Options ...

Q Run Q Close 0

Input Volume: Normally the standard poststack seismic volume is a good default input
for computing TFL. In case the seismic is extremely noisy, we suggest to first filter the
raw seismic using our structurally oriented median filter, and then use the filtered seis-
mic as input for TFL. Furthermore, if you have a color inverted seismic or spectraly
blued seismic volume, then using that as input is recommended over the standard seis-

mic volume.

Volume subselection: this is useful if you the user want to speed the process, a subse-

lection area can be set.

Advanced settings
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\%Advanced parameters for Fault Likelihood - O X

-

Filter size (sample) |in:2 % er:2 1 Z:32 ]

Maximum dip (us/m) |800 ‘

Fault strike scan range in degrees |0 $ 360 ¢ Nrsteps “
Strike scan smoother (16 3+

Fault dip scan range in degrees |25 : 65 ¢ Nrsteps
Dip scan smoother (20 3

Velocity ( m/s ) [2500 |

o | @

Filter Size (inl/crl/sample): Smaller step-outs used in FL dip computation, e.g. 1-1-16
or 2-2-32, capture small scale features. However, bigger FL dip computation step-outs
e.g. 4-4-100, significantly improve the characterization of the bigger fault lineaments by

improving their connectivity.

Fault likelihood scan setting: The algorithm will scan for the fault dips and strikes
within a given range of the dips to maximize the fault likelihood. The input parameters
here depend on how flat/steep the seismic data is. If you are dealing with a layer cake
data set, small angle range would be reasonable. Nr Steps is how many scans should
be done. Initially the full strike (0 - 360 degrees) and a large dip range (25 - 65 degrees)
should be tested. Afterwards, better (more realistic) results can be achieved by con-
straining the strike/dip range. As a rule of thumb, it is always recommended to use

wider dips and strikes to extract more information from the data.

Velocity (m/s) Velocity needs to be used in time surveys to convert angles. Use an

average value for your data set, it will not affect the results much.

Apply thinning: The user should select yes in order to output the Thinned Fault Like-
lihood.
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2.1.2 Thinned Fault Likelihood (TFL)

{% Faults and Fractures 3D Control Center - O X
Available Attributes

Fault Likelihood (FL)

Thinned Fault Likelihood (TFL)

Create TFL from FL

Basement Fracture Likelihood
Thinned Basement Fracture Likelihood

—

e I Attributes
o
o

Convolve (Edge Enhancement)
Curvature

Dip/Azimuth Attributes

Fault Dip/Azimuth

Fault Painter

Finger Vein Attribute

Fracture Density/Proximity
Gradient/Azimuth of Curvature
Semblance

Similarity

Filters

Tools

Go ...

€3 Close e =)

Thinned Fault likelihood or TFL is a revolutionary new attribute that produces accurate
and sharp faults. The thinned Fault likelihood attribute which is defined as a power of
semblance, has a range of value between 0 and 1.This attribute is developed aiming to
capture and delineate faults and fractures in area of interest, such that the algorithm
scans the range of fault dips to identify maximum likelihood. The Thinned fault like-
lihood attribute provides razor-sharp fault images on horizontal slices as well as on ver-

tical sections (Figure 1). Fault likelihood attribute is used as input to directly compute
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density of fractures in a given area and the proximity of fractures with each other (Fig-
ure 2). This new plugin also comes with a new, edge-preserving smoothing filter. This
smoothing algorithm uses Thinned Fault Likelihood attribute as input. It generates seis-
mic volumes with razor-sharp edges that are very well suited for structural inter-
pretation (Figure 3). For further quantitative work milder filters such as the dip-steered

median filter are needed.

Figure 1. Smoothed seismic with Thinned Fault Likelihood attribute overlay.

Distance from fracure cenber Densily fracbunos oees
e e ' ;
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Figure 2. Fracture Density (right) and Fracture Proximity (left) attributes computed

from Thinned Fault Likelihood attribute.




Figure 3. Result of the new smoothing filter (first grey image above) on seismic data

(second grey image above). North Sea example

Workflow

To access the fault likelihood plugin, click on this icon ™= .

% Faults and Fractures 3D Control Center - O X
Available Attributes

Fault Likelihood (FL)

Thinned Fault Likelihood (TFL)

Create TFL from FL

Basement Fracture Likelihood
Thinned Basement Fracture Likelihood

L]

rop o —
]
ey
L rey
=
W

Attributes

Convolve (Edge Enhancement)
Curvature
Dip/Azimuth Attributes
Fault Dip/Azimuth
Fault Painter
Finger Vein Attribute
% Planes Fracture Density/Proximity
‘ Gradient/Azimuth of Curvature
Semblance
Similarity

Filters

Tools

Go ...

€3 Close 0 (=)

Parameters
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%Create Thinned Fault Likelihood - O X

Input Cube *'E ‘4 Dip steered median filter v ‘ © Select ...

Volume subselection 100/300-750/1250 (463 samples) - © Select ...

@ Advanced Settings

Output Cube | - © Select ...

Batch execution Single Process ~ 4, Options ...

€3 Close 9

Input Fault Likelihood Cube: Select or Create a Fault Likelihood Volume.

Volume subselection: this is useful if you the user want to speed the process, a subse-

lect